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WDReportGen Frequently Asked Questions 

 

About 

 

What is WDReportGen? 

WDReportGen is a report generator for Microsoft Word that outputs reports in 

Microsoft Word document format. 

 

What can I do with it?  

If you know how to use Microsoft Word and write SQL statements, you can use 

WDReportGen to create all kinds of reports as you need. The report generated 

by WDReportGen is a Microsoft Word document. 

 

What is the system requirement? 

WDReportGen 5.1: 

- Microsoft Windows XP, Windows Server 2003, Windows Vista, Windows 

Server 2008, Windows 7 or later. 

- Microsoft .NET Framework 4. 

- Open XML SDK 2.5 for Microsoft Office. 

WDReportGen 4.0: 

- Microsoft Windows XP, Windows Server 2003, Windows Vista, Windows 

Server 2008, Windows 7 or later.  

- Microsoft Office 2003, Office 2007, Office 2010 or later. 

- The Microsoft .NET Framework version 3.5 SP1. 

WDReportGen 3.9: 

- Microsoft Windows 95, Windows 98, Windows NT, Windows 2000, 

Windows XP, Windows 2003 or later. 

- Microsoft Office 97/98, Office 2000, Office XP, Office 2003 or later. 
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- Visual Basic 6.0 run-time environment 

 

Do I need to install Microsoft Office? 

WDReportGen 5 was developed using OpenXML SDK. You do not need to 

install Microsoft Office for WDReportGen 5. However, WDReportGen 4 / 

WDReportGen 3 were developed using Microsoft Word Visual Basic. You 

need to install Microsoft Office for WDReportGen 4 / WDReportGen 3. 

 

What are the differences between the different versions of 

WDReportGen? 

 
WDReportGen 5 WDReportGen 4 

WDReportGen 3 / 

WDReportCom 1 

Office API OpenXML SDK 
Microsoft Office 

Interop 

Microsoft Word 

Visual Basic 

Programming 

Language 
Visual Basic .Net Visual Basic .Net Visual Basic 6.0 

Supported 

Operating 

System 

Microsoft Windows 

XP, Windows 

Server 2003, 

Windows Vista, 

Windows Server 

2008, Windows 7 

or later. 

Microsoft Windows 

XP, Windows 

Server 2003, 

Windows Vista, 

Windows Server 

2008, Windows 7 

or later. 

Microsoft Windows 

95, Windows 98, 

Windows NT, 

Windows 2000, 

Windows XP, 

Windows 2003 or 

later. 

Need Office No Yes Yes 

Supported 

Office 
- 

Microsoft Office 

2003 or later 

Microsoft Office 97 

or later 

Other Software 

Required 

Microsoft .Net 

Framework 4 and 

Open XML SDK 2.5 

Microsoft .Net 

Framework 3.5 

Visual Basic 6.0 

run-time files 

Supported 

Word File 

Format 

OpenXML 

Document 

Word 97-2003 

Document, 

OpenXML 

Document 

Word 97-2003 

Document, 

OpenXML 

Document 

File Convertor No Yes Yes 

Refresh Table 

of Contents 

and (Formula) 

No Yes Yes 
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Fields 

Supported 

Charts 
Office 2007 chart 

Office 2007 chart, 

Excel chart OLE 

object, Graph chart 

OLE object 

Excel chart OLE 

object, Graph chart 

OLE object 

Performance Fast Slow Slow 

32-bit or 64-bit 32-bit and 64-bit 32-bit and 64-bit 32-bit 

 

Where can I find WDReportGen 4? 

After you have installed WDReportGen 5, you can find “WDReportGen4” 

directory under the WDReportGen directory. The directory contains the files of 

WDReportGen 4. 

 

What are the differences between the editions of WDReportGen? 

There are 2 types of editions issued for WDReportGen. 

1) WDReportGen Standard Edition 

User can execute no more than 50 SQL statements in one report processing. 

2) WDReportGen Professional Edition 

User can execute SQL statements unlimitedly in one report processing. 

 

Do I need 32-bit WDReportGen or 64-bit WDReportGen? 

WDReportGen 3 is 32-bit software. WDReportGen 4 and WDReportGen 5 

include 32-bit and 64-bit software. 

32-bit WDReportGen can run on 32-bit or 64-bit windows. But it must run with 

32-bit data provider (such as ODBC driver, OLEDB driver) and 32-bit Microsoft 

Office (WDReportGen 5 does not need Microsoft Office). 

64-bit WDReportGen must run on 64-bit windows. And it must run with 64-bit 

data provider (such as ODBC driver, OLEDB driver) and 64-bit Microsoft Office 

(WDReportGen 5 does not need Microsoft Office). 

 

Can I make the complex report using WDReportGen? 
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Yes. This is a main feature of WDReportGen. The complexity might come from 

reports formatting as well as reports content. 

- The complex report formatting  

You design reports like layouts, styles, formatting directly using Microsoft Word. 

You can take full advantage of Microsoft Word including characters formatting, 

paragraphs formatting, bulleted and numbered lists, borders, shading, headers 

and footers, automatic formatting, style, graphics, diagrams, and more. 

- The complex report content 

In one report, you can execute more than one SQL statement, and get data 

using different queries. Further more, you can create a temporary table, 

prepare data using many SQL statements including 

INSERT/UPDATE/DELETE/INSERT SELECT, and then make a report.  

 

Do you have any server version which I can use on the server to generate 

the reports?  

No. But WDReportGen can be run on your desktop or server. So you can use 

WDReportGen on the server to generate the reports. If you want to run it in the 

background on the server, you need to run it in command line mode. 

 

When I run wordreport.exe from the command line, I receive a 

“’wordreport’ is not recognized as an internal or external command, 

operable program or batch file.” error message. 

Your windows can not find the “wordreport.exe”. 

1. You can refer to wordreport.exe as the full path. 

For WDReportGen 32-bit, 

"C:\Program Files (x86)\LJZsoft\Wordreport.exe" c:\myreport.wrf –c 

For WDReportGen 64-bit, 

"C:\Program Files\LJZsoft\Wordreport.exe" c:\myreport.wrf –c 
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2. You also can add the path of wordreport.exe to System PATH variable. 

(1) Choose Start -> Settings -> Control Panel. 

(2) Double-click System. 

(3) Select the Advanced tab and then Environment Variables. 

(4) In System Variables, look for PATH. Select PATH, and click SET button. 

(5) Add the path of wordreport.exe and click OK button. 

 ;C:\Program Files\LJZsoft 

(6) Click OK button. 

 

Reporting with WDReportGen 

 

How does it work?  

To create a report with WDReportGen, you should do as follows: 

1. Create a report template file using Microsoft Word, define the layouts, styles, 

formats of reports. 

2. Create a WRF file with a .wrf extension using WDReportGen. The WRF file 

tell WDReportGen how to extract data from database, and where and how to 

put data. 

3. Run the WRF file to generate a report in Microsoft Word document format. 

 

Where can I find some samples? 

After WDReportGen is installed, some sample reports are installed too. The 

sample reports include a sample database, some report template files (.docx) 

and WRF files (.wrf). They are located in the WordReport directory under 

\Samples. 

 

What need I do to use samples? 

To use these samples, you must add a data source named “Report Sample”, 
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and specify the database “Sample.mdb”. If you have not installed MS access 

ODBC driver, please install it first. 

Creating a System DSN for a Microsoft Access Database 

1. Click the Windows Start button, choose Settings, and then click Control 

Panel. 

2. Double-click Administrative Tools, and then double-click Data Sources 

(ODBC). The ODBC Data Source Administrator dialog box appears. 

3. Select the System DSN tab, and then click Add button. 

4. Choose Microsoft Access Driver (*.mdb), then click Finish button. 

5. In the ODBC Microsoft Access Setup dialog box, type Report Sample in 

the Data Source Name box. 

6. Click the Select button, and browse to select Sample.mdb. 

7. Click OK button to close the ODBC Microsoft Access Setup dialog box. 

8. Click OK button to close the ODBC Data Source Administrator dialog box. 

 

How can I use these samples? 

1. Run WDReportGen. 

2. Open a WRF file. Click Open on the File menu. 

3. Run the WRF file to generate a report. Click Run on the Report menu. 

4. Open, view and check the report. Click Open Report File on the File menu. 

5. Open, check the log file. Click Open Log File on the File menu. 

The sample reports can be changed to adapt to your own needs. 

 

When I use samples, I receive a "Selected Collating Sequence Not 

Supported" error message. 

This is a problem of multilanguage. You are trying to open a database or an 

object in a database that was created in another language edition of Microsoft 

Access. You can try as follow: 
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1. Open the database "sample.mdb" using Microsoft Access.    

2. On the Tools menu, click Options, and then click the General tab.   

3. Make sure that the New Database Sort Order is set to General and then 

click OK. 

If you do not resolve the problem, please install or enable multilanguage 

support for your operating system. For more information, please refer to 

http://support.microsoft.com/default.aspx?scid=KB;en-us;q202150 

http://support.microsoft.com/default.aspx?kbid=184988 

You can create a new database on your computer, export data from 

“sample.mdb”, and import into your database. 

 

What is a report file? 

The report file is a Microsoft Word document generated by WDReportGen. 

 

What is a report template file? 

To make a report using WDReportGen, you should create a report template file 

first. This report template is a Microsoft Word document that defines the 

layouts, formats and styles of the report. In the report template, you can input 

static content such as titles, descriptions, comments, a cover, a company logo, 

and set the format for the static content and data got from data sources. 

 

What is a WRF file? 

To generate a report with WDReportGen, you must create a WRF file with 

a .wrf extension. The WRF file contains information such as the name of the 

report template file, the name of the report file, log file name, data sources, 

parameters and functions. The WRF file tells WDReportGen how to get data 

from data sources and how to put data into a report. 

 

http://support.microsoft.com/default.aspx?scid=KB;en-us;q202150
http://support.microsoft.com/default.aspx?kbid=184988
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What is a function? 

A function includes a SQL statement and some arguments. A function can be 

used to execute a SQL statement, and tell WDReportGen whether or how to 

add data into a report. 

 

How can I connect a data source using a connection string? 

To write a connection string, please refer to  

http://www.connectionstrings.com 

 

Instead of SELECT statements can I use Stored Procedures? 

Yes, you can use Stored Procedures. 

 

When I execute a SQL statement, I receive an "ODBC driver does not 

support the requested properties." error message. 

It probably is a wrong SQL statement. Such as a missing column, or syntax 

error. 

 

When I execute a SQL statement, I receive an " Too few parameters. 

Expected 1." error message. 

It is a wrong SQL. 

 

How can I test a SQL statement? 

You can test SQL statements using Microsoft Query that is a component of 

Microsoft Office. You can find it under the installation directory of Microsoft 

Office. 

“C:\Program Files\Microsoft Office\OFFICE11\MSQRY32.EXE” 

 

How can I sort data? 
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Use SQL to sort your data. In a SELECT statement, you can use the ORDER 

BY clause to have your results displayed in a sorted order. 

 

How can I have total?  

To add totals, you can use the aggregate functions in SQL statement, such as 

COUNT, SUM, AVG, MAX, and MIN. 

(1) In the fixed table report, you can add total directly using a separate SQL. 

(2) In the variable table report, you must add the total first using a fixed table 

report function before you use the variable table report function. Because the 

cell address of the total field will change after you use the variable table report 

function. 

 

How can I group data? 

To group data in a report, you should use GROUP argument in the REPORT 

function. For more detail information, refer to WDReportGen Help and the 

samples customer_profile.wrf, invoice.wrf, product_catalog.wrf and 

sales_detail.wrf within WDReportGen. 

 

How can I make sub reports within the main report?  

A subreport is a report within a report. A subreport would typically be used to 

perform one-to-many lookups such as Customer / Order / OrderDetails. 

To make sub reports within the main report,  

1. Write a JOIN SQL statement to get data from two or more tables. For 

example, you can join Customers, Orders and OrderDetails tables. 

2. Use GROUP argument in the REPORT function. 

For more detail information, refer to the samples invoice.wrf, 

product_catalog.wrf and sales_detail.wrf within WDReportGen. 
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How can I have sub-totals for each group? 

You can add sub-totals using the aggregate function in SQL statement. 

1. Use aggregate function and GROUP BY clause, get summary data for each 

group, and insert results into a temporary table. 

2. If you have the different kinds of summaries, repeat the step 1, and insert 

results into another temporary table. 

3. Use the variable table report function, and join the detail data and the 

summary data using JOIN. The summary fields must be included in the group 

list. 

4. Except for sub-totals, you can add total too using aggregate function in SQL 

statement. You must add total first using a fixed table report function before 

you use the variable table report function. Because the cell address of the total 

field will change after you use variable table report function. 

For more detail information, please refer to the samples invoice.wrf and 

sales_detail.wrf within WDReportGen. 

 

How can I create charts? 

To create a chart in a report, you should create the chart in the template file. 

You can create a chart using Microsoft Excel. 

1. Open the report template file using Microsoft Word. 

2. Place the insertion point where you want to create the chart. On the Insert 

tab, in the Illustrations group, click Chart. 

3. In the Insert Chart dialog box, click a chart, and then click OK button. 

Microsoft Excel will open and display sample data on a worksheet. 

4. Enter the sample data into the worksheet of the chart. 

5. Customize your chart, and choose the chart type and the various chart 

options. 

6. Delete the sample data. 
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 If the report type is fix, you should define the blank ranges according to 

number of records.  

 If the report type is var, you should define one or two blank ranges. 

7. When you've finished, click the Microsoft Office Button in Excel, and then 

click Close. 

8. Write functions in a WRF file to input the data. 

For more detail information, please refer to the sample monthly_sales.wrf 

within WDReportGen. 

 

How to use parameters? 

In SQL statements, you can use parameters.  

1. To use a parameter, you must declare it first. A parameter has a name, a 

title and a default value. To define a parameter, click Configuration on the 

Report menu, and click the Parameter tab 

2. In SQL statements, use the parameter name. 

WDReportGen will replace the parameter name with the actual value before it 

submits the SQL statements to data sources. 

Example 

Define a parameter as follows:  

Name: $CustomerName 

Title: Customer Name 

You can use the parameter name "$CustomerName" in SQL statements. The 

parameter name in SQL statements should be delimited by quotation mark. 

For example:  

SELECT CompanyName 

,CityName 

,CountryName 

,ContactName 
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FROM Customers, Cities, Countries 

WHERE Customers.CityCode = Cities.CityCode 

AND Customers.CountryCode = Cities.CountryCode 

AND Customers.CountryCode = Countries.CountryCode 

AND CompanyName LIKE '$CustomerName%' 

 

I need to change paths for both exported report and template location. Is 

there any way? 

You can use parameters in the path and name of the report file, template file 

and log file. For example, you define a parameter $CustomerID, you can name 

the report file as follows: 

report\report_$CustomerID.docx 

report\$CustomerID\report.docx 

 

Can I place the data into columns rather than rows?  

Of course, just write FILLORDER=col in REPORT function. For example, there 

are 1 field and 10 records, you can show them as 1 row and 10 columns on 

report. 

 

How to create Microsoft Word reports with pictures? 

You can insert pictures into your report from using many popular graphics files 

WDReportGen. 

1. Store the path and name of the graphics files in the database. 

2. Identify the image fileds in the report function. 

3. To specify the inserted way, text wrapping style and size, you can write a 

formatting expression into the cell or field in the report template file. 

WDReportGen will read the graphics files, insert them into the report, and set 

the inserted way, text wrapping style and size of the pictures. 
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Do I need to execute more than 1 SQL statement in one report 

processing? 

In most of reports, you just need to execute one SQL statement. But 

sometimes, you want to execute more than one SQL statement in one report 

processing. 

 The data are located in different tables or databases, and you get data 

using different queries. 

 There are many reports in one report file. 

 You want to create a temporary table, prepare data using many SQL 

statements including INSERT/UPDATE/DELETE/INSERT SELECT, and 

then make a report. 

 

How many SQL statements can I execute in one report processing? 

It is dependent on the license of WDReportGen you have purchased. For 

detailed information, see Licenses. 

 

I want to programmatically change some of the functions in the wrf file. 

How? 

The WRF file is a text file. You can write a program to make a WRF file using C, 

perl or DOS shell, and then run WDReportGen to generate report. These steps 

can be written into a batch file. 

 

I hope the report can not be modified. How can I do? 

You can protect the generated report so that it can not be modified. To protect 

the report, select the Protect Report check box in the Configuration dialog 

box. 
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Support 

 

How much will I pay for the technical support? Is it free?  

Yes, it's completely free for all. 

 

I have more questions - who should I write to? 

Please send your additional questions to support@ljzsoft.com. 

 

mailto:support@ljzsoft.com

